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Introduction 

MultiSpect Analysis is designed for Kromek’s range of USB radiation detectors giving 

easy connection and setup, and analysis functions tailored to the detectors and their 

applications. MultiSpect Analysis Premium adds advanced functions for the 

quantitative analysis of activity which are not present in standard MultiSpect 

Analysis. 

KSpect is a free version of the software with capabilities for data acquisition from one 

gamma and one neutron detector at a time, and basic peak region of interest analysis, 

without the advanced features of MultiSpect Analysis.  

In order to use MultiSpect Analysis a licence is required that is supplied by Kromek 

which enables either the standard or the premium features. Without a valid licence, 

or after a trial licence has expired, MultiSpect Analysis will run with only the KSpect 

features available.  

Software Installation 

KSpect and MultiSpect Analysis are compatible with Windows 7 and 8. 

To install the software double click the setup.exe file.  

Microsoft SQL Server is installed alongside KSpect and MultiSpect Analysis. The 

installer will prompt the user if additional downloads are required from Microsoft 

during the installation process. 

Software Updates 

The software will check for updates periodically. If an update is found on the server 

the user is notified and given the option to download and install the update. The user 

can make the software check whether an update is available by selecting ‘Check for 

Updates’ from the ‘Help’ menu. If there is no internet connection on the computer 

running KSpect or MultiSpect Analysis installer files can be downloaded from the 

Kromek website. If the current licence will not work with the updated software the 

user cannot download the update. Notifications for updates which require a licence 

upgrade can be turned off by clicking ‘File’, followed by ‘Preferences’, and then 

clicking the checkbox for hide incompatible updates. 

Licensing  

When MultiSpect Analysis is run for the first time it will ask the user to enter a licence. 

The licence controls which features are available to the user. A new licence can be 

applied at a later time by selecting ‘Enter New Licence’ from the ‘Help’ menu.  
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Activating a licence 

A licence can be activated in one of three ways:  

1. Over the internet using a licence key  

2. Via another computer that has an internet connection using a licence key (if 

you have no internet connection on the computer where the software is 

installed)  

3. Using a file if you have been supplied with a licence file instead of a key  

Please select the appropriate option and follow the on-screen instructions.  

Moving a licence 

To move your software licence to another machine please contact Kromek to have 

your licence reset. Moving your licence is free provided the licence is still valid. 

Upgrading your licence 

To upgrade your licence please contact Kromek for a new licence key. The new licence 

can then be applied by selecting ‘Enter New Licence’ from the ‘Help’ menu. 
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Main Screen Overview 

When first loading KSpect or MultiSpect Analysis the main window is displayed: 

 

A. The menus at the top of the screen contain controls for starting an acquisition, 

viewing the data and choosing the analysis that is performed on the measured data. 

Double clicking the menu headings allows it to be hidden giving more space for the 

display of data. Shortcut buttons on the top title bar always give convenient access 

to the most important functions regardless of which menu tab is displayed. These can 

be configured from the drop down menu to the right of the shortcuts. 

B. The plot area shows the data acquired from the detectors. When the ‘Spectra’ tab 

is selected the energy spectra from the detectors are displayed, and when the 

‘Monitors’ tab is selected the count rate against time is plotted for the detectors. 

Note that only spectra are visible in KSpect. 

C. When on the ‘Spectra’ tab a spectrum data box gives information on the active 

measurement and detector. 

D. Every detector connected to MultiSpect, and every loaded measurement, is given 

a thumbnail. The thumbnail gives controls over just that single set of data. Clicking 

the thumbnail makes it active, shown by a green border, and all analysis is performed 

on the active measurement.   

A 

B 

C 

D 
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Connecting Detectors 

Connect a compatible detector to the computer using a USB cable. The software will 

recognize the hardware and indicate that the device is connected in the status bar at 

the bottom of the window. 

The software displays a dialog listing the newly-connected detector, asking you to 

enter or confirm the serial number of the detector: 

 

Enter the serial number of the detector and click OK. 

The device is now ready to start acquiring data. 

Detector serial numbers 

KSpect and MultiSpect Analysis allow you to enter calibration data and other device 

settings for each detector and save this information for future use when the same 

detector is connected again. It is important to use the same serial number for the 

detector each time you connect that detector so the correct stored values are used.   

You must give each detector a unique serial number. The serial number can be any 

text, but we suggest you use the serial number printed on the detector if possible. If 

you have more than one detector connected, you can see which is which by checking 

the Port names in the dialog. The Port names identify the USB ports you have 

connected the detectors to, and will be the same when you connect the detectors 

again. 

When you re-connect a detector on the same USB port, KSpect/MultiSpect assumes 

that this is probably the same detector you last connected to that port, and puts the 
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serial number of that detector in the serial numbers dialog. So if you always use the 

same detectors in the same USB ports, all you have to do after the first time is check 

that the serial numbers in the dialog are correct, and click ‘OK’ or press the [Enter] 

key. 

The software remembers each serial number you have used. So if you change which 

detector is connected to which port, you can simply select the correct serial number 

from the drop-list of serial numbers beside each detector. 

If you choose the wrong serial number, and you only realize this after you have closed 

the dialog, just disconnect the detector and re-connect it - The software will display 

the dialog again so you can select the correct serial number. 

Known detectors can be managed by selecting ‘Manage Detectors’ from the ‘Setup’ 

menu allowing editing of device information and records of old detectors that are no 

longer used to be removed.  

 

• Create can be used to add a new detector.  

• Edit will allow the serial number or the device type to be changed.  

• Delete removes the detector and all associated calibrations.  

Selecting detectors in KSpect  

KSpect is limited to only acquiring from one gamma ray detector and one neutron 

detector at any one time. If multiple detectors are connected the active detector can 

be selected from the ‘Setup’ menu. 
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Acquiring Data 

MultiSpect Analysis can acquire from all connected detectors simultaneously. KSpect 

supports acquisition from one single gamma ray detector and one neutron detector 

at a time. The active detector can be selected from the Setup menu.  

Starting data acquisition 

Pressing the ‘Acquire’ button located either on the ‘Acquisition’ menu or shortcut 

menu at the top, or pressing [F1], will begin collecting data from all the enabled 

detectors.  

When detectors are first connected they are enabled for data collection by default. If 

multiple detectors are connected it is possible to disable an individual detector to 

stop data being recorded during acquisition using the button on the detector 

thumbnail (see page 12). 

Clearing acquired data 

MultiSpect Analysis can simultaneously display results from multiple detectors and 

loaded measurements. At any one time there is one selected or "active" 

measurement, which is chosen by clicking on a thumbnail, and is highlighted by a 

coloured border around the thumbnail.  After selecting the thumbnail showing the 

data to be cleared press the ‘Erase’ button, or the [F2] key, to clear the data. 

Acquisition time limits 

The acquisition of data can be stopped automatically after a user specified time limit 

has elapsed. Two different time limits are available: real time and live time. Real time 

is the total duration of the measurement. Live time is the total time the detector has 

been active and able to record data. The values of these limits are set using the ‘Real 

time’ and ‘Live time’ limits controls located on the ‘Acquisition’ menu.        

A limit of zero will be ignored and allow acquisition to continue indefinitely. If both 

limits are set to non-zero values, the one that is reached first will stop the acquisition. 

If both limits are zero, the acquisition will not stop until the ‘Stop’ button, or the [F1] 

key, is pressed. The limits can only be adjusted when the acquisition is not active. 

Performing auto-repeats  

Repeated acquisitions of a fixed duration can be saved into the database 

automatically. They are configured from the ‘Acquisitions’ menu. All enabled 

detectors will be included in the repeat measurements. 

To perform repeated acquisitions: 
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1. Set the number of measurement to perform in the ‘Acquisitions’ field. Set 

this value to ‘1’ to disable repeated acquisitions. 

2. Provide a ‘Save Name’ that will be used for the measurements in the 

database. This ‘Save Name’ will have the number of the repeat appended 

when saved. The ‘Same Name’ will be used for measurements from all 

detectors in the acquisition. 

3. To clear the data before each repeat tick the ‘Clear on each acquisition’ 

check box. 

4. Provide a ‘Live Time’ and/or ‘Real Time’ limit for each repeat. 

5. Enable/disable the detectors you wish to include/exclude from the 

acquisitions using the controls on the detectors’ thumbnails. 

6. Start the acquisitions by clicking the ‘Acquire’ button. 

7. Repeat acquisitions can be cancelled at any time by clicking the ‘Stop’ 

button. All completed acquisitions up to that point will have been saved into 

the measurement database. 

Overflow bin suppression 

The highest channel of a spectroscopic detector is used to collect all counts that are 

higher than the upper range of the detector. This can result in a spike appearing at 

high energies depending on the type of detector being used. To avoid this spike the 

overflow counts can be suppressed. This suppression is configured under ‘File’ and 

‘Preferences’. Suppression is enabled by default when the software is first installed. 

Spectrum Cursor 

A vertical dashed line in the plotting area of the ‘Spectra’ tab forms a cursor allowing 

data to be read from the graph and several different operations such as region of 

interest (ROI) selection, energy calibration, and lower level discrimination (LLD) 

adjustment. 

The position of the cursor can be shifted by a single channel using the [Left] or [Right] 

arrow keys on the keyboard. Larger steps in the cursor position are obtained by 

pressing the [Page Down] or [Page Up] keys. Left-clicking the mouse anywhere on the 

spectrum plot will also move the cursor to that channel in the spectrum.  

The ‘Cursor data’ section of the spectrum data box gives the spectrum information at 

the position of the cursor. 

Detector and Measurement Thumbnails 

Below the data plots section are the thumbnails. Each thumbnail shows a miniature 

representation of the data from the detector. The source of the data is shown 

underneath and there is a toolbar of buttons to manage the data at the top.  Hovering 
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the mouse over the thumbnail will display the serial number or measurement name 

of the thumbnail. 

The buttons on the toolbar save the data (if it has changed since the last save), hide 

or show the data in the main plot, and clear or close the measurement. There is also 

an ‘enable/disable acquisition’ button; when acquisition is started, only those 

detectors that are enabled will acquire data. The input spectra to an aggregate can 

also be configured from the thumbnail. During acquisition, the enable and disable 

acquisition buttons are disabled.  

 

 

Additional functions are available by right clicking the thumbnail. For example, data 

can be copied to a new thumbnail by right clicking the existing thumbnail and 

selecting "Copy". This is particularly useful for preserving acquired data and using it 

for comparison. 

After loading a measurement, the information on the measurement can be seen by 

right clicking the thumbnail and selecting ‘Measurement Information‘. A window is 

displayed showing information including any associated neutron measurements. This 

window also allows some of the data to be edited. 

 

Spectrum Display Settings 

Spectrum display settings can be found on the ‘Spectra’ menu. The menu will only be 

visible when the ‘Spectra’ view is shown. 

Enabled Save Hidden Visible Set Inputs Clear Disabled 
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Zooming  

Pressing ‘Zoom in’ at the top, or pressing the [F4] key, zooms in at the position of the 

cursor. The plot area is split into two sections, the top showing the full range spectrum 

and the lower the zoomed in region. Pressing ‘Zoom in’ again increases the level of 

magnification. Zooming can also be achieved with the mouse wheel after clicking on 

the spectrum. 

Clicking at a different point on the top spectrum changes the region shown in the 

zoomed in section of the display. Directly beneath the plot area is a scroll bar that can 

also be used to change the view area when the horizontal scale has been zoomed in. 

Additionally, right-clicking the mouse when the pointer is over the spectrum display 

will bring up a context menu with selections for zooming.  

The spectrum can be returned to full scale by repeatedly pressing ‘Zoom Out’ / [F5] 

or pressing ‘Full Scale’ / [F6]. 

Vertical scale  

The vertical axis of the spectrum plot is in units of counts. The maximum displayed 

value can be changed using the Vertical scale controls located on the ‘Spectra’ menu. 

Pressing the [Up]/[Down] arrow key will also move the axis maximum counts stepping 

up/down through the available values.  

This maximum counts value can be set to a fixed value, or to automatically adjust to 

the maximum value of the data being plotted. You can choose whether auto-scaling 

adjusts to accommodate all spectra or just the active spectrum in the program 

‘Preferences’ from the ‘File’ menu. 

Channels or energy on horizontal axis 

Note: This functionality is not present in KSpect 

Spectral data from a detector can be plotted by raw channel number where the 

counts have been detected. If an energy calibration exists for the detector, providing 

the conversion of channel to energy, the spectrum can also be plotted on an energy 

scale. To enter an energy calibration see the calibration section. The ‘Energy mode’ 

button located on the ‘Spectra’ and ‘Analysis’ menus allow the user to switch 

between displaying the spectrum in channel and energy modes: 
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When multiple detectors are connected their spectra may not be directly comparable 

because of differences in the energy calibrations. MultiSpect Analysis transforms the 

channel counts into energy bins using an interpolation algorithm to reassign event 

counts from the detector channels to the normalized energy channels, maintaining 

the total counts from the detector. The user can select the energy interval using the 

‘interval’ drop down box. In this energy display mode the spectra from different 

detectors are directly comparable and operations can be performed to combine 

detectors.  

Visible spectra 

Any number of spectra can be loaded into memory and displayed with MultiSpect 

Analysis. KSpect is limited to 5 spectra at a time. Each spectrum can be made visible 

or hidden by clicking on the show/hide button in the toolbar of the spectrum’s 

thumbnail. The currently active spectrum must be visible and therefore its visibility 

button is disabled. 

Spectrum colour 

The colour used to display the spectrum can be changed by right clicking the 

thumbnail and selecting ‘Colour’. 

Energy Calibration 

Each spectral detector has its own energy calibration for converting the channel 

number to the energy of that channel. Using a suitable radiation calibration source 

the energy of particular channels can be measured. When two or more data points 

for the calibration are entered the energy calibration will automatically be calculated. 

The energy calibration is determined through a fit of the channel-keV conversion data 

points to a straight line. 

To enter a calibration right click the detector thumbnail and select ‘Energy 

calibration’. This can also be done by selecting the thumbnail and clicking ‘Energy 

calibration’ located on the ‘Acquisition’ menu. A data grid will be displayed allowing 

pairs of channel and energy values to be entered: 
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Using this window, data points can be directly entered into the data grid.  The ‘Add 

Cursor Point’ button will set the channel cell in the current spreadsheet row (the row 

where the spreadsheet cursor is positioned) to the channel value of the spectrum 

cursor.  

A shortcut for entering calibration points is to position the cursor on the active 

spectrum and enter the keV value in the text box in either the ‘cursor data’ or in the 

‘centroid’ of the ‘ROI data’ of the data box below the spectrum.  

The ‘Delete Point’ button will delete the data contained in the current spreadsheet 

row. Deleting a data point can also be accomplished by selecting and deleting the 

energy value associated with the point in the spreadsheet. Finally, pressing the ‘Reset’ 

button deletes all the data points clearing the calibration. 

The calibration for the active spectrum can be copied from that of another spectrum 

loaded in memory by selecting ‘Copy Calibration From’ and then selecting the source 

spectrum from the drop-down list.  

When modification of the calibration is finished, the calibration window can be closed 

using the standard widow close button located at the upper right corner of the 

widow.  
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Efficiency Calibration 

Note: This functionality is only present in MultiSpect Analysis Premium 

Where the detector and radioactive sources are used in a fixed geometry an efficiency 

calibration of the system can be used, together with the measured count rates in 

spectrum peaks, in calculating source activity.  Tools are provided allowing the user 

to determine the efficiency of their system using a calibration source of known 

activity. The detector must have an energy calibration and a resolution calibration 

before an efficiency calibration can be entered, and the spectrum must be displayed 

in ‘Energy Mode’ with an energy horizontal axis (see page 14). 

Defining the calibration 

The efficiency calibration is defined in the “Detector Settings” window which can be 

opened from the “Setup” ribbon menu, or by right-clicking the 

measurement/detector thumbnail. The “Efficiency Calibration” tab shows the 

calibration, the fit to the data and the 1 standard deviation confidence limits on the 

fit to the data. The graph can be viewed on either a linear or log scale by changing the 

option in the dropdown box above the graph. 

 

Each efficiency point, ε, in the efficiency calibration is defined from: 

� = �
���  

Where:  

R is the measured photopeak net count rate,  

S is the activity of the source on the measurement date, and  

Pγ is the probability of emission of the gamma rays being measured. 
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All efficiency calibration points must be made with the same the peak region of 

interest width factor setting for analysing the net counts in the peak. 

The error on the data point is calculated from the errors on the net count rate and 

the source activity.  

After recording a spectrum from a calibration source of known activity place the 

cursor on a photopeak and press the ‘Add cursor point’ button.  An efficiency 

calculation window is displayed allowing the efficiency and error to be determined 

for the selected peak. 

 

Choose the radionuclide and emission line for the selected peak. MultiSpect will 

measure the net counts in the peak. The number of bins used on each side of the 

peak for determining the background to be subtracted can be adjusted with the 

‘upper’ and ‘lower’ window controls under the display of the peak. 

Enter the calibrated activity of the source and the one standard deviation uncertainty 

in the activity for the reference date when the source was calibrated. MultiSpect uses 

the half-life of the radionuclide for calculating the activity on the spectrum 

measurement date. 

The calculated efficiency and error are displayed at the bottom of the screen. To add 

this as a data point to the efficiency curve press ‘Add’. 
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Fit to the efficiency data 

MultiSpect fits the efficiency data points with the following curve: 

ln	�
 = �� + �� ln	�
 + ��ln		E
� +⋯+ ��ln		E
� 

Where:  

ε is the efficiency,  

E the energy,  

ai are fitted coefficients,  

and the order of fit, n, is between 3 and 7.  

The user must select the order of fit most suitable for their data from the control on 

the ‘Efficiency Calibration’ tab. The ±1σ errors on the fitted line are shown with pale 

pink lines on the calibration curve. It is important to inspect these errors to identify 

if the chosen curve is a realistic fit to the data.  

Note that the validity of the fit outside the region where data points lie falls rapidly 

and causes large errors on the extrapolated values. A wide range of data points 

should be included in the calibration.  

Managing efficiency calibrations  

Saving and loading efficiency calibrations 

After an efficiency calibration has been entered it can be saved for future use by the 

‘favourites’ menu. This allows several efficiency curves to be stored for different 

geometries. The same menu allows a stored calibration to be loaded to the detector. 

Only one efficiency calibration can be loaded at a time and this is the one used for 

analysis.  

When a measurement is saved in the database the efficiency calibration is saved with 

that measurement for future use.  

Copy calibration from another measurement or detector 

The efficiency curve can be copied from another live detector or loaded measurement 

to another by using the ‘copy calibration from…’ option on the ‘efficiency calibration’ 

tab of the ‘detector settings’ window.  

Exporting/Importing efficiency calibrations 

Efficiency calibrations can be exported and imported from the star menu to move 

them to other computers which use the same detector or where analysis will be 

continued. 
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Other Device Settings 

Depending on the particular type of detector that is connected additional settings 

may be available. These are all displayed in the "Device Settings" window from the 

"Setup" menu or from right clicking the thumbnail. These operations are described 

below. They relate to the active thumbnail and clicking between thumbnails will show 

the settings for the chosen detector or measurement. 

Lower level discriminator (LLD) adjustment 

The LLD is a setting of the attached detector. This setting is a channel value 

corresponding to a pulse height below which the spectrometer should ignore all 

pulses. To adjust the LLD, click ‘Set LLD’ from the ‘General tab’ of device settings. The 

spectrum cursor will change to one labelled Set LLD and will appear at the location of 

the current LLD setting. The LLD setting is then adjusted by moving the cursor. The 

cursor can be moved with the arrow keys, with the [page up]/[page down] keys, by 

left-clicking with the mouse anywhere along the spectrum, or by left-clicking on the 

cursor and dragging with the mouse. The LLD is typically set to cut out the noise 

counts at the low energy side of the spectrum. After the desired LLD is set, select ‘Set 

LLD’ again to exit the set LLD mode. 

Software cut off 

In addition to the hardware LLD a software cut off can be applied. This is purely in the 

software and is specified in channels relative to the hardware LLD position. To set this 

cut off first enable the cut off with the checkbox and then enter the number of 

channels offset on the ‘General’ tab of ‘Device Settings’. 

Dead time factor 

KSpect and MultiSpect Analysis calculate dead time in the detectors based on a single 

dead time factor which is set on the ‘General’ tab of the ‘Device Settings’ window. 

Total dead time, D, is calculated from: � = 	�	��, where τ is the dead time constant, 

M is the measured count rate, and T is the real time. The live time, L, is then 

calculated from: � = �		1 − ��
. 

Polarity adjustment 

When connected to a Multi-Channel Analyser (MCA) the polarity of the incoming 

pulses to the MCA must be set. This is done from the ‘General’ tab by selecting either 

positive or negative from the polarity section. 
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Resolution calibration 

The variation of the resolution of the detector with respect to channel is shown in the 

Resolution Calibration tab. This is used in the peak analysis functions within 

MultiSpect Analysis. 

Save neutron counts in gamma spectrum 

If a neutron detector is connected that only measures neutron counts, not a 

spectrum, there is an option within the neutron detector device settings to save the 

neutron data within gamma-ray measurements of all gamma-ray detectors 

connected at the same time. This enables the neutron field to be measured and 

recorded alongside the gamma-ray data for future analysis. This is available in both 

KSpect and MultiSpect Analysis. 

Spectrum Data Box 

On the ‘Spectra’ tab below the spectra is a pane containing data associated with the 

spectrum acquisition, spectrum plot scales, cursor, and current region of interest. 

Spectrum acquisition data 

Real time is the total time that has elapsed during the acquisition of pulse height data. 

Live time is the length of time that the pulse processing hardware has actually been 

active and able to detect pulses during the data acquisition. In other words, live time 

is the real time reduced by the total time that the hardware has been inactive as a 

result of pulse processing activities. Dead time is the instantaneous percentage of 

time that the hardware is inactive as a result of pulse processing activities rather than 

being able to detect pulses.  

Count rate is the number of events detected per second shown both as a number and 

via a horizontal graphical bar. Rates displayed are not corrected for dead time in the 

detector and show the instantaneous rate, not the average rate over the total 

acquisition time.  

Scale ranges 

The next data group from the left, scale ranges, lists the maximum number of counts 

used for the vertical axis of the spectrum plot and the number of channels that the 

horizontal axis currently spans. If the active spectrum has been calibrated in energy, 

the horizontal axis range is also given in keV.  
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Cursor position 

The next data group from the left, cursor data, lists the current cursor location on the 

active spectrum in counts, channels, and keV (if calibrated). 

The text box displaying the horizontal location in keV may also be used as a data entry 

box to assign an energy value to the current cursor location in the energy calibration. 

The data entry mode is entered by clicking the keV text box. The desired energy can 

then be entered, and, after [Enter] has been pressed, the energy calibration will be 

updated by adding the new channel-keV data point to the existing energy calibration.  

Region of interest (ROI) 

When the spectrum cursor is positioned in a defined ROI the measurements of the 

ROI will be displayed in the ROI data group below the spectrum. See the region of 

interest operation section (see page 26). The information includes the summed 

counts, centroid, and full-width-at-half-maximum (FWHM) of the peak. Whether a 

background is subtracted or not from the ROI is controlled from the Spectra tab of 

the ribbon menu at the top of the screen. 

The text box listing the Centroid in keV may also be used as a data entry box to assign 

an energy value to the current centroid channel location in the energy calibration, in 

a similar way to using the cursor position text box. Left click the keV text box and the 

desired energy can then be entered, and, after [Enter] has been pressed, the energy 

calibration will be updated by adding the new channel-keV data point to the existing 

energy calibration. 

Active device 

For the active device or measurement thumbnail the active device box shows the type 

of the detector used to record the data, the serial number of that device, the Lower 

Level Discriminator (LLD) setting, and the setting of the Software Cut-Off (SCO).  
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Monitor Traces 

Note: This functionality is not present in KSpect 

When the ‘Monitors‘ tab is clicked above the plot area the count rate monitor traces 

are displayed for all the connected detectors. Each trace allows changes in the count 

rate recorded from the detector to be seen over time.  Monitor traces are only 

updated during acquisition and are not dead time corrected. Press the ‘Acquire’ 

button located on the ‘Acquisition’ menu to begin acquisition. Moving the mouse 

pointer over the monitor trace displays a cursor and an information box showing the 

count rate and the time at that point on the trace. 

Note: MultiSpect Analysis reads data from the detectors via USB. Depending on the 

computer being used to run MultiSpect Analysis buffering of USB data can cause 

delays in receiving data from the detector and add noise on monitor traces with short 

aggregation times. This will become more pronounced if the computer is running 

many processor heavy tasks or has insufficient free resources. 

By default each detector has one monitor showing the total count rate from all energy 

channels, although different energy ranges can be configured manually. This is useful 

for monitoring the count rate in one particular gamma ray peak for example. 

Monitors for neutron detectors only show the total counts detected. Monitor traces 

are automatically saved against each detector serial number so the next time the 

detector is connected the previously configured monitor traces are displayed again. 

 

The time period being viewed can be chosen by using the drop down menu located 

on the ‘Monitors’ menu. For each time period 121 data points are shown. The time 

periods available are: 
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Time Period Shown Data aggregated over 

2 minutes 1 second 

30 minutes 15 seconds 

1 hour 30 seconds 

4 hours 2 minutes 

12 hours 6 minutes 

1 day 12 minutes 

Individual monitor traces can be removed by using the red cross on each trace. All 

monitors from a detector can be hidden by clicking on the ‘hide’ icon on the detector 

thumbnail which also hides the spectra on the ‘Spectra’ tab.  

Adding a new monitor 

New monitor traces can be added by first selecting the detector thumbnail and then 

clicking the ‘Add monitor’ button located on the ‘Monitors’ menu. This will bring up 

the ‘Rate Monitor Settings’ window 

 

A name should be given for the monitor for identification. The filters can be used so 

that only the aggregated counts from a particular region of the spectrum are plotted 

in the monitor trace.  

Editing the monitor settings 

The settings for a particular monitor trace can be viewed and edited by clicking the 

‘settings’ button on the monitor trace, or by right clicking on the trace and choosing 

‘settings’ from the menu. The ‘Rate Monitor Settings’ dialog is displayed from which 

the name can be changed and the energy range or channel range used in the monitor 
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can be edited. Changes made to the monitor take effect from then on; old data is not 

recalculated to show it on the same basis. 

Saving and exporting the monitor data 

Monitor data cannot be saved in the measurement database. It can be exported to a 

.csv file to preserve a record of the data. Press the export button on the monitor trace 

to save the data for the time period being viewed. 

Exported data has a header section showing the settings for the monitor. The data is 

in rows with a row for each time period. Each row has a time stamp, the total counts 

recorded in that period, and the total real time the detector was acquiring data during 

that time period. The count rate can be recalculated by dividing the total counts by 

the real time.  

Clearing the monitor data 

All the data for a particular monitor can be cleared by pressing the ‘clear’ button on 

the monitor trace, or from the right-click menu. This will permanently erase the data. 

File Operations 

Spectrum load 

Opening a spectrum directly from a file can be done from the "File" menu by choosing 

"Open a file", or by dragging and dropping a spectrum file into the main window.  

Spectrum save  

Complete measurements comprising the spectrum, energy calibration and all analysis 

are saved in a database of measurements, from where they can be exported if 

required. A measurement can be saved to the database by first selecting the 

thumbnail and then either selecting "Save measurement" from the "File" menu, by 

pressing the save icon on the thumbnail, or by pressing the [F3] key. On first saving 

the measurement the user will be asked to provide details including a name and notes 

that are needed for finding the measurement in the database. These can be edited 

later if required. For details of working with the database please see the database 

section of this help file.  
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Copy spectrum 

Spectrum data can be copied to a new thumbnail by right clicking the existing 

thumbnail and selecting "Copy". This is particularly useful for storing acquired data 

and using it for comparison. 

Reports 

The spectrum and analysis results can be presented together in a convenient report. 

This is exported in .pdf format for ease of sharing. The ‘Generate Report’ button is 

located on the ‘Reports’ menu. The report options will be displayed for choosing 

which information should be shown on the report.  

The units of measurement used in the report can be configured between SI and US 

standard units from the ‘Preferences’ screen which is accessible from the ‘File’ menu.  

Printing 

A snapshot of the KSpect or MultiSpect Analysis window can be printed by selecting 

‘Print’ from the ‘File’ menu. This then brings up a standard Windows print dialog from 

which a specific printer along with its associated properties can be selected. After this 

selection has been made, the snapshot of the window can be sent to the printer by 

clicking on the ‘OK’ or ‘Print’ button of this print dialog window. Prior to printing, the 

print settings can be adjusted by selecting ‘Print settings’. The snapshot can also be 

previewed by selecting ‘Print preview’.  

Region of Interest (ROI) Operations 

When a ROI is defined about a peak in a spectrum, and the cursor is placed within this 

ROI, the ROI data in the spectrum data box displayed beneath the spectrum provides 

the counts, centroid, and FWHM values associated with the peak.  

The integral counts value is simply the sum of all the counts within the ROI, whereas 

the net counts number is this same sum reduced by the background counts. The 

background is assumed to be a line determined based on the data points at the start 

and end of the ROI. If the background subtraction has been turned off from the 

‘Spectra’ tab of the ribbon menu the integral and net counts will be the same. The 

centroid and FWHM values are given in number of channels and, if a valid energy 

calibration exists in keV. The centroid and FWHM calculation is performed on the net 

counts if background subtraction is turned on, or the integral counts if it is turned off.  

Each spectrum has its own set of defined ROIs and only those of the active spectrum 

will be displayed. A ROI is indicated on a spectrum using colour shading. ROIs are only 

displayed when the ROIs are turned on. This state is toggled between on and off by 
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the ‘ROI show/hide’ button. This state can also be toggled by right-clicking the mouse 

when the pointer is over the spectrum display and then selecting ‘ROI on/off’ from 

the menu. The display of ROIs is also turned on if a ROI definition is started. 

Defining a region of interest (ROI) 

ROIs can be defined using several different methods, but each of the methods makes 

use of the spectrum cursor to specify the start and stop channel of the ROI. The 

function key buttons ‘ROI start’, ‘ROI stop’, and ‘ROI clear’ can be used to define or 

remove a ROI. With the cursor positioned at the start channel of the desired ROI, 

clicking on ‘ROI start’ or pressing the [F8] function key starts the ROI definition. The 

text of the button then changes to ‘ROI stop’. The ROI definition is then completed by 

moving the cursor to the end channel of the ROI and then clicking on ‘ROI stop’ or 

pressing the [F8] function key again. A ROI can be removed by positioning the cursor 

within the ROI and then clicking on ‘ROI clear’ or pressing [F9]. Similarly, ROI definition 

and clearing operations can be accessed through the menu that is activated by right-

clicking the mouse when the pointer is over the spectrum display. A quick method to 

define ROIs is to hold down the shift key while left-clicking with the mouse on the 

start channel of the ROI. The ROI definition is completed by again holding down the 

shift key while clicking on the stop channel of the ROI. 

Region of interest calculations 

The Integral Counts value is simply the sum of all the counts within the ROI and is 

calculated as follows: 

Integral	Counts = 	 ' (�
ROIstop

�,ROIstart
 

Where Cn is the number of counts in channel number n, and ROIstart and ROIstop are 

the channel number limits of the ROI.  

The Net Counts number is the Integral Counts less the Background Counts. The 

background Bn is assumed to be a straight line determined from the data points at 

the start and end of the ROI.  

The Net Counts values are calculated as follows: 

Net	Counts = 	 ' 	(� − .�

ROIstop

�,ROIstart
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The Centroid in units of channel number is calculated from the background-

subtracted count data using the equation: 

Centroid = 	∑ 2	(� − .�
ROIstop
�,ROIstart
∑ 	(� − .�
ROIstop

�,ROIstart
 

The FWHM in units of channel number is determined using the following procedure: 

(1) The background is subtracted from the count data.  

(2) The channel containing the maximum counts, Cmax, is determined through a 

simple search.  

(3) Starting from this maximum-counts channel, the lower channel numbers are 

searched for a pair of adjacent channels whose counts straddle a counts value of 

Cmax/2.  

(4) The lower half-maximum channel value is then calculated from these two 

straddle points through linear interpolation.  

(5) In a similar manner, the upper half-maximum channel value is determined 

through a search of the higher channel numbers starting at the maximum-counts 

channel followed by a linear interpolation calculation using the data points that 

straddle a counts value of Cmax/2.  

(6) Finally, the FWHM is calculated by subtracting the lower half-maximum channel 

value from the upper half-maximum one.  

If an energy calibration has been completed for the active spectrum, the Centroid and 

FWHM values in channels are converted to energy in keV using the energy calibration. 

Summing Spectra 

Note: This functionality is not present in KSpect 

Summing multiple spectra 

MultiSpect Analysis provides a sum function that can sum the channel events counts 

from multiple spectra. The results of the sum are displayed in an additional spectrum, 

known as an aggregate spectrum.  

This is only available in energy display mode (see page 14) where only spectra with 

valid energy calibrations are displayed and available for aggregation. Aggregate 

spectra are not displayed in channels display mode. 
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You can create a new aggregate spectrum by clicking on the ‘Create’ button  

located on the ‘Analysis’ menu. MultiSpect creates a new aggregate spectrum 

thumbnail, distinguished by a ‘sum’ symbol (sigma character) in the left-most button 

on the thumbnail: 

 

To select the spectra to be summed, click on the ‘sum’ button  in the thumbnail 

toolbar. This displays a window showing all the spectra that can be summed. Valid 

spectra include detector and file spectra with valid energy calibrations. Tick the 

checkboxes next to the spectra you want to sum: 

 

If you reset the calibration of a spectrum that is being used as the input to a sum, that 

spectrum is automatically removed from the sum because only calibrated spectra can 

be summed. 

Saving an aggregate spectrum 

An aggregate spectrum can be saved just like any other spectrum. When an aggregate 

spectrum is saved, a copy of each input spectrum is also saved. 

Loading an aggregate spectrum 

When an aggregate spectrum is loaded from a file, a spectrum is also created for each 

of the spectra that were inputs to the aggregation when the aggregate spectrum was 

saved. Clicking on the "sum" button on the thumbnail’s toolbar opens a tool window 

that allows you to select which spectra act as inputs to the sum in the aggregate 

spectrum. 
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Measurement Database 

To allow a spectrum to be saved with the analysis and other associated data such as 

locations, KSpect and MultiSpect Analysis use a database for storing complete 

measurements. This provides a single location for organizing measurements and all 

measurements can be backed up collectively. All users logging on to a particular PC 

share the same database with all measurements accessible to everyone. 

The database can be opened from the ‘File’ menu by selecting ‘Measurement 

Database’, or from the shortcut at the top.  

 

Loading a measurement 

Select the measurement in the database window and press the ‘Load’ button. 

Saving a measurement 

After selecting a spectrum thumbnail the measurement can be saved to the database 

either from the ‘File’ menu by selecting ‘Save Measurement’, by pressing the save 

icon on the thumbnail, or by right clicking the thumbnail and selecting ‘Save 

measurement’. On first saving the measurement the user will be asked to provide 

details including a name and notes which are needed for finding the measurement in 

the database. These can be edited later if required. 
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Importing spectra to the database 

Pressing the import button allows existing .spe spectrum files to be imported to the 

database. Many .spe files can be imported at the same time by selecting multiple files 

in the file browser dialog box. 

Editing measurement information 

Measurement information can be edited by first selecting the measurement and then 

selecting ‘Edit information’ from the toolbar buttons at the top. 

Importing measurements from a Kromek device 

Note: This functionality is not present in KSpect 

MultiSpect Analysis can synchronize data with some Kromek devices, such as the 

RayMon handheld radiation monitor. Connect the Kromek device to the PC running 

MultiSpect Analysis with a USB cable. 

The first time the device is connected drivers will be downloaded and installed from 

the internet. If you do not have an internet connection on the PC running MultiSpect 

Analysis please download the following software and drivers from the Microsoft 

website on another PC and install them on the PC running MultiSpect Analysis. When 

the software drivers are successfully installed the Kromek device will appear in 

Windows Explorer under the ‘Computer’ heading.  

• Windows XP users: Microsoft ActiveSync 4.5 or later  

• Windows 7 and 8 users: Windows Mobile Device Centre 6.1 or later  

After connecting the device press ‘Import From Device’ at the top of the 

‘Measurement Database’ window to display the ‘Device Import’ window listing all the 

measurements stored on the device.  
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Select the measurements to import by ticking the checkboxes next to the 

measurements.  

Pressing ‘Import selected’ imports all the selected measurements.  

The ‘Select’ menu at the top of the window allows different selections to be made:  

• Select all measurements on the device  

• Clear all the selections so none are selected  

• Select all new measurements not previously imported (shaded green) 

• Select measurements that have been modified on the device since they were 

last imported  (shaded blue) 

• Select all new and modified measurements  

To delete the selected measurements from the device after import tick the checkbox 

‘delete from device after import’. 

To delete measurements from the device without importing select the 

measurements and click ‘Delete Selected’. 

Finding measurements 

The filters on the left of the measurements database window allow searching for 

particular spectra within the database. These allow searching by:  

• Date spectrum recorded  

• Date measurement was last edited  

• Name  

• Detector serial number  

• Detector Type  

• The device type used to capture the data from the detector, e.g. a PC 

• The serial number of the capture device 

• Contents of the notes associated with the spectrum 

Completing any of the filters automatically filters out all the non-matching 

measurements in the database. To return the filters to their default values press the 

‘Reset’ button.  

Exporting Data 

Gamma ray spectra can be exported to .spe, .n42 or .txt file by selecting the 

measurement and pressing the ‘Export’ button. 

Neutron data can be exported to a .neutron file by selecting the measurement and 

pressing the ‘Export’ button. 
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Settings 

The settings button brings up a menu allowing the default time period for displayed 

measurements when the database is first viewed to be configured. This value should 

be reduced if the database is slow to load. Which columns are visible can also be 

configured from this menu. 

 

Backup 

The complete database of measurements can be backed up to a single file from the 

‘File’ menu by selecting ‘Backup database’.  

Restore 

To restore a database select ‘Restore Database’ from the ‘File’ menu and choose 

which backup file to restore. All data in the existing database will be lost when a 

previous database is restored. Administrator privileges are required for restoring the 

database. If the user is not an administrator they will be prompted to enter the 

username and password of an administrator.  

Reset 

The database can be reset to a blank default database from the ‘Database Settings’ 

dialogue window. This is opened from ‘File’ → ‘Database’ → ‘DB SeTngs’ and the 

reset option is found on the ‘Admin’ menu.  Administrator privileges are required for 

the reset; if the user is not an administrator they will be prompted to enter the 

username and password of an administrator.  

 

  



 
34 

Spectrum Peak Analysis 

MultiSpect Analysis has powerful features built in to automatically analyse peaks 

from radiation source energy lines. Note: these features are not available in KSpect.  

After selecting which radiation sources may be in the spectrum and MultiSpect 

Analysis automatically analyses a suitable region of interest around each energy line 

and tells you whether a significant peak exists at each energy. 

Note: analysis is only available in energy display mode. The analysis features operate 

on the active spectrum. The analysis updates automatically while data is being 

acquired. 

Enabling peak analysis 

Peak Analysis is only available after moving to energy mode. Click the ‘Energy Mode’ 

button on the analysis toolbar. 

                                         

Configuring peak analysis 

Analysis is configured in the ‘Peak Analysis Nuclides’ and ‘Peak Analysis Options’ 

windows. In these windows you can: 

1. Select which radiation sources you expect may be present in the spectrum  

2. Filter the energy lines of the radiation sources so only the important energy 

lines are analysed  

3. Create your own categories and add radiation sources to them, so that you 

can find and include your ‘favourite’ sources quickly  

4. Change the analysis parameters  

5. Look up radiation source energy lines by energy and relative intensity  
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The peak analysis nuclides window 

 

Choosing radiation sources 

MultiSpect Analysis has a library of all the common radiation sources and their 

significant energy lines. The upper tree shows the radiation sources grouped by ANSI 

category. The less common sources do not belong to an ANSI category, and are 

grouped under the ‘(Uncategorised)’ heading. A few sources belong to more than one 

ANSI category, and so appear more than once in the tree. 

The ‘Search’ box makes it easy to find a radiation source. Enter the full nuclide name, 

such as ‘Co-60’, or just the first few characters of the name. Clear the search box and 

get back to the full tree by clicking on the  button. 

Click on the checkbox beside the name of the radiation source to add it to the analysis. 

Click on the checkbox again to remove the radiation source from the analysis. 

Choosing energy lines 

The lower tree shows the selected radiation sources, each with its energy lines. Each 

energy line has a relative intensity. This shows the intensity of the energy line relative 

to the other energy lines of the same radiation source, such that the sum of the 

relative intensities of all the included energy lines of a radiation source is 100%. 

Note: some energy lines may not appear in the list. Energy lines outside a 

configurable energy window, or below a specified minimum relative intensity, are 

hidden when the filter button at the top of the window is enabled, and displayed in 

grey when the filter is disabled. The energy window and minimum relative intensity 

are set in the analysis configuration options window.  
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User-defined radiation source categories 

Custom categories can be created and radionuclides added to them. This makes it 

easy to find the radiation sources frequently used. Unlike the other information in 

the analysis configuration form, which is saved in an analysis configuration file, the 

user-defined categories are saved in the MultiSpect Analysis application preferences 

and apply to all analysis configurations.  

To create a new category, either click on the  button or right-click on any existing 

category to display the context menu and then click on ‘Add new category...’. The 

new category is added to the tree. Enter a name for the category. The name must be 

different from the existing categories. Rename or delete the category by right-clicking 

on it and choosing ‘Rename’ or ‘Delete’ from the context menu. Note: you can’t 

rename or delete the default ANSI categories. 

To add a radiation source to a user-defined category, right-click on the radiation 

source in the tree. The context menu shows the list of user-defined categories, with 

a tick beside each one that the radiation source already belongs to. Click on a category 

in the context menu to add the radiation source to or remove it from the category. 
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Peak analysis configuration options 

 

Minimum intensity: energy lines with a relative intensity less than this level can be 

hidden using filter buttons on other windows.  

Energy: energy lines with an energy outside this range can be hidden using filter 

buttons on other windows.  

Upper and lower background window: the energy span outside either end of the 

peak-region that is sampled for the background. The background is calculated by 

fitting a straight line through the background channels. Where data is not in 1keV bins 

the number shown in brackets displays the actual energy range being used.  

Second proportion of max: the analysis results table shows the full-width at half-

maximum (FWHM) for each detected peak, and another full-width at this proportion 

of maximum. For example, if this value is set to 0.1, the second full-width is the full-

width at one-tenth of maximum. The full-width ratio shown in the analysis results 

table is this width divided by the full-width at half-maximum.  

Peak ROI width factor: defines the percentage of peak events that are covered by the 

region of interest based on the resolution function of the detector with respect to 

energy. 

Critical limit: the analysis uses a Critical Limit test to determine whether a significant 

peak exists at the energy. This value sets the confidence level for the Critical Limit 

calculation.  

Confidence limits:  the analysis calculates upper and lower confidence limits for the 

net counts in a peak, and, if an efficiency calibration is present, the source activities. 

This value sets the confidence level for the confidence limit calculation.  
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Minimum and maximum half-life: A range of half-lives can be specified and only 

energy lines from radiation sources that fall within this window are analysed.  

Peak area and FWHM analysis results  

The ‘Peak Analysis Table’ is displayed when the “Results” menu button is clicked. View 

the ‘Peak Area’ tab to see the measurements of peak areas and full widths at half 

maxima (FWHM). 

 

The analysis results are colour coded for ease of interpretation as follows: 

• Green: the spectrum has a peak in the same energy region above the level 

of statistical confidence specified in the analysis configuration options; the 

critical limit test has been passed.  

• Blue: the spectrum fails the critical limit test in this region.  

• Red: lines that have been excluded from analysis because they fall outside 

the conditions specified in the analysis configuration options  

The shading within each colour indicates the relative intensity of the line. For example 

a dark blue is a line with a high relative intensity where the critical limit test has been 

failed. 

The table shows a list of all the energy lines included in the analysis. Column headings 

can be clicked to sort the data. 
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• Source: the radiation source of the energy line.  

• Energy: the energy of the energy line in keV.  

• Centroid: the centroid of the region in keV. If a background line could be 

determined, this is the centroid of the net count, else of the gross count.  

• Gross count: the total of all counts in the region of interest.  

• Net count: the gross counts less the counts below the straight line 

connecting the average counts in the left-hand background window of the 

region of interest with the average counts in the right-hand background 

window.  

• Upper and lower confidence: the Confidence Limits for the net count in the 

peak, to the configured confidence level (see above). This defines the range 

containing the true (rather than measured) number of events due to the 

energy line, to the configured level of confidence.  

• FWHM: full-width at half of maximum in keV. The width of the peak (net 

counts only) at half the maximum net counts in the peak.  

• FWnM: full-width at n of maximum in keV. The width of the peak (net counts 

only) at the configured "second full width proportion of maximum" of the 

maximum net counts in the peak.  

• FW ratio: the ratio of FWnM to FWHM.  

The buttons on the top bar perform the following operations: 

 

Filter energy lines above the critical limit and associated nuclide lines: 

with is enabled the analysis table only shows radionuclides where at 

least one line has passed the critical limit test. 

 

Filter relative intensity: when enabled emission lines that fall below the 

specified minimum intensity are hidden from the analysis results table. 

 

Filter energy range: when enabled emission lines that fall outside the 

specified energy window are hidden from the results table. 

 

 

Filter half-life: If enabled emission lines from radionuclides with half 

lives outside the specified range are hidden from the results table.  

Analysis results can be exported by selecting ‘Export…’ from the top of the Peak 

Analysis Table. The exported data contains additional columns, such as the critical 

limit used to test for the presence of a peak. 

Activity from peak areas 

Note: This functionality is only present in MultiSpect Analysis Premium 

After determining the efficiency calibration curve of the system, see the calibration 

section on page 17, the activity of a source of can be measured from the net counts 

in its spectrum peaks. The sample must be positioned in the geometry matching the 

efficiency curve, and the Peak ROI width factor for the analysis must be the same. 

Simply acquire a spectrum from the source in the geometry of the efficiency curve 

and perform a Spectrum Peak Analysis (see page 34) to measure the photo-peaks in 
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the spectrum. On the ‘Peak Analysis Table’ click the ‘Peak Activity’ tab to view the 

results of the analysis in terms of activity using the efficiency curve loaded in 

‘Detector Settings’. Only peaks that have passed the critical limit test where a net 

count rate has been measured are analysed for activity. The units of measurement 

can be changed between SI and US Standard from the ‘Preferences’ screen accessed 

from the main ‘File’ menu. 

The efficiency curve can be viewed by pressing ‘View Efficiency Calibration…’ above 

the results table, and a new calibration loaded if necessary.  If no efficiency curve is 

present no results will be displayed. 

 

Each emission line analysed gives a separate measure of the activity of the sample. 

The upper and lower confidence values are calculated using the error from the fit to 

the efficiency calibration points, the error in the net counts measured from the 

spectrum, and the ‘confidence limits’ chosen by the user in ‘Peak Analysis Options’, 

e.g. 1σ/68%. 

Activity results can be included in .pdf reports (see page 26). They can also be 

exported to a .csv file by using the ‘export…’ button above the results table. When 

the measurement is saved in the database the complete configuration is saved with 

the measurement allowing the same analysis to be recalled at a later date. 

Graphical display of analysis 
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When analysis is enabled, the graphical display shows the regions of interest of the 

peaks being analysed. Each energy line in the analysis is shown with: 

• A vertical dotted line at the energy of the energy line. This line is strongly 

dashed if a peak was detected. Otherwise it is lightly dotted.  

• Text beside the peak, with the nuclide name, energy line energy and user-

entered comment.  

• Vertical dashed lines at the right and left boundaries of the region of interest.  

• Shading of the region of interest under the spectrum trace.  

• Darker shading below the background level in the region of interest.  

All the energy lines of a radiation source are shown in one colour. The energy lines of 

different radiation sources are shown in different colours. 

If a peak was detected in the region of interest, the graphical display of the energy 

line is shown brightly. Otherwise it is shown dimly, unless you hover the mouse over 

an element of the energy line (the centre energy line, a region of interest bounds line, 

or the text). 

The filters on the “Analysis” menu bar can be used to control what analysis 

information is displayed on the graph. 

 

 

Show/hide all ROI lines: pressing this shows/hides the dashed lines 

marking the limits of the region of interest for each radionuclide line 

from the graph. 

 

Show/hide all text: pressing this shows/hides text labels on the graph. 

They are still displayed when the mouse is hovered over the peak centre 

markers.  

User-entered comments 

Comments can be added or edited by right-clicking on the energy line in the graphical 

spectrum display and choosing ‘Edit text’ in the menu. 

Saving and loading the analysis configuration 

The analysis configuration will be saved with the spectrum in the database and 

recalled the next time the measurement is opened.  

If the analysis configuration will be used frequently it can be added to the list of 

favourite configurations allowing it to be quickly applied to any spectrum. 
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• Save favourite configuration: After setting up the analysis click on ’Save as 

favourite...’ in the favourites menu above the radionuclide selection tree and 

name the configuration to add it to the list of favourites.  

• Apply favourite configuration: An existing favourite can be applied to a 

spectrum by selecting it from the drop down list above the radionuclide tree.  

• Organise Favourites: Favourite configurations can be managed by selecting 

"Organise favourites..."  

 

• Choose default favourite configuration: After selecting a favourite select 

‘Set Default’ to make this the default configuration for future 

measurements.  

• Rename favourite configuration: The name of the favourite can be changed 

by selecting it and pressing ‘Rename’.  

• Delete favourite configuration: To remove a favourite configuration select 

it and click the ‘Remove’ button.  

• Export/Import favourite configuration: A favourite configuration can be 

exported to a .msa file so it can be saved and transferred to other MultiSpect 

Analysis installations. To export select the configuration and click the 

‘Export’ button. To import a .msa file click ‘Import’ and navigate to the file.  
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Simplified Activity Analysis in MultiSpect 

Note: Quant for GR1 users need to apply an enhanced MultiSpect Analysis Premium 

software licence to enable these activity features.  

Activity analysis quantifies the radioactivity of a sample from its gamma ray spectrum 

which must be recorded in a pre-defined geometry using the Quant for GR1 

accessories. The efficiency values used for the analysis are provided in the software, 

removing the need for the user to characterise the system. If required, the efficiency 

values can be updated by the user after calibration. 

After selecting which radiation sources may be present and sample type in the 

measurement, MultiSpect Analysis calculates the quantity of each radionuclide. The 

analysis features operate on the selected spectrum and the analysis updates 

automatically while data is being acquired.  Activity analysis is only available in energy 

display mode. 

Disclaimer: When using the provided efficiency values the activity results will be 

compromised if the sample or geometry deviates from the ideal case. The user is 

responsible for qualifying the system and ensuring the results are appropriate for 

their needs. 

Starting activity analysis 

                               

After or while acquiring a spectrum switch to energy mode by clicking on the ‘Energy 

mode’.  

Configuring activity analysis 

Activity analysis is configured from the ‘Activity Analysis Options’ window and the 

‘Activity Analysis Nuclides’ window. The units of measurement can be changed 

between SI and US Standard from the ‘Preferences’ screen which can be accessed 

from the main ‘File’ menu. 
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Choosing radiation sources 

MultiSpect Analysis will analyse the sample for common radiation sources. The 

‘Activity Analysis Nuclides’ tree shows the radiation sources grouped by ANSI 

category that are available for analysis. Click on the checkbox beside the name of the 

radiation source to add it to the analysis. Click on the checkbox again to remove the 

radiation source from the analysis. The ‘Search’ box makes it easy to find a radiation 

source. Enter the full nuclide name, such as ‘Co-60’, or just the first few characters of 

the name. Clear the search box and get back to the full tree by clicking on the  

button.  

 

User-defined radiation source categories 

Custom categories can be created and radionuclides added to them. This makes it 

easy to find the radiation sources frequently used. Unlike the other information in 

the analysis configuration form, which is saved in an analysis configuration file, the 

user-defined categories are saved in the MultiSpect Analysis application preferences 

and apply to all analysis configurations.  

To create a new category, either click on the  button or right-click on any existing 

category to display the context menu and then click on ‘Add new category...’. The 

new category is added to the tree. Enter a name for the category. The name must be 

different from the existing categories. Rename or delete the category by right-clicking 

on it and choosing ‘Rename’ or ‘Delete’ from the context menu. Note: you can’t 

rename or delete the default ANSI categories. 

To add a radiation source to a user-defined category, right-click on the radiation 

source in the tree. The context menu shows the list of user-defined categories, with 

a tick beside each one that the radiation source already belongs to. Click on a category 

in the context menu to add the radiation source to or remove it from the category. 
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Analysis configuration options 

 

These parameters configure the analysis:  

• Upper and lower background windows: The background under a peak in the 

spectrum has to be removed before activity can be calculated. The 

background is calculated from the counts just outside the peak region; these 

settings change the energy range used in this calculation.  

• Peak ROI width factor: This defines the percentage of the peak area that is 

included in the calculations. A wider region of interest will give a more 

accurate result, but will be more susceptible to interference from 

radionuclides with peaks in a similar region of the spectrum.  

• Confidence level for critical limit: The analysis uses a critical limit test to 

determine whether a significant peak exists or not. This value sets the 

confidence level for this critical limit test calculation.  

• Confidence level for quoted uncertainty: the analysis calculates the 

uncertainty in the calculated activity. This value sets the confidence level 

used in calculating the uncertainty.  
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• Sample type: The type of sample being analysed affects the geometry of the 

measurement and needs to be taken into account in the calculation of the 

activity. Select one of the options for the type of sample being measured:  

o Maypack (Charcoal) for standard Maypack charcoal filters  

o Filter for filter papers  

o Maypack (Charcoal) and Filter for a combined measurement of 

Maypack charcoal and filter paper  

o Beaker is for a standardised beaker filled with material. If this 

option is selected additional parameters are required for the 

volume and weight. The material is assumed to be uniformly 

distributed in the beaker, with a density matching water, and with 

negligible self-absorption of radiation.  

o Calibration Source is for use with the standard calibration source. 

Calibration source = QCRB19952 NG3 mix from HTSL (High 

Technology Sources Ltd)  

o Raymon Filter for analysis of data imported from a RayMon 

handheld detector using the RayMon Quant accessories.  

o Raymon Beaker for analysis of data imported from a RayMon 

handheld detector using the RayMon Quant accessories.  

Results 

 

The ‘Activity analysis table’ shows the results of the activity analysis. Column headings 

can be clicked to sort the data. The ‘Export’ button allows the results to be saved in 

.csv format.  

Columns show:  

• Source: The radionuclide that has been analysed  

• Result: The calculated activity of the radionuclide  

• Uncertainty: The uncertainty in calculated activity  

• MDA: The minimum detectable activity for the radionuclide in the 

measurement. This provides an upper limit on the activity where it has not 

been possible to quantify the radionuclide.  
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Saving and loading the analysis configuration 

The analysis configuration will be saved with the spectrum in the database and 

recalled the next time the measurement is opened. 

If the analysis configuration will be used frequently it can be added to the list of 

favourite configurations allowing it to be quickly applied to any spectrum.  

 

• Save a favourite configuration: After setting up the analysis click on ‘Save as 

Favourite’ in the favourites menu above the radionuclide selection tree and 

name the configuration to add it to the list of favourites.  

• Apply favourite configuration: An existing favourite can be applied to a 

spectrum by selecting it from the top of the drop down list above the 

radionuclide tree.  

• Organise Favourites: Favourite configurations can be managed by selecting 

‘Organise Favourites’. 

 

• Choose default favourite configuration: After selecting a favourite select 

‘Default’ to make this the default configuration for future measurements.  

• Rename favourite configuration: The name of the favourite can be changed 

by selecting it and pressing ‘Rename’.  
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• Delete favourite configuration: To remove a favourite configuration select 

it and click the ‘Delete’ button.  

Calibration of simplified activity 

Specific efficiency values, ke, used in this simplified activity analysis for each 

radionuclide can be updated from user acquired absolute efficiency curves. These 

must already have been recorded with a “Peak ROI Width Factor” of 95.45%. Please 

see page 17 for creating this calibration curve. 

From the ‘Setup menu’ select ‘Radionuclide Efficiency Values’. 

 

This will open a window allowing the values used in the efficiency analysis to be 

updated. First select the geometry and then select the efficiency curve to use for 

calculating the new values. Calculated ke values, which are the efficiency values 

adjusted for the probability of emission of the radionuclide emission line, are 

displayed in the table. To accept these new values press the ‘Apply’ button. 

 

To revert back to the pre-determined values from Kromek select the ‘Kromek 

Default Values’ in the efficiency drop down box. Changes to these ke values will 

affect all measurements, including historic measurements in the database. Note 

that in this simplified activity calculation the errors on the fit to the efficiency curve 

are not taken into account in calculating the errors on the final activity.  
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Scripting 

KSpect and MultiSpect Analysis provide the ability to automate various operations 

through a scripting system. This scripting capability is accessed by selecting ‘Script 

Window’ under the ‘File’ menu. From this window, scripts can be loaded, edited, 

saved, compiled, and executed. The scripts must be written in the C# language 

(Microsoft Visual C# 2005) and must follow the form given in the examples below.  

Control of the software is provided through the properties and methods described in 

the help on the scripting window of KSpect and MultiSpect Analysis. Please refer to 

this help file for the full list of properties and methods.  

Example: repeat measurements with a single detector 
 

namespace USBSpect{ 

    public class Script : ScriptInterfaces.IScriptScript 

    { 

        ScriptInterfaces.IScriptHost pspect; 

 

        public void InitializeScript(ScriptInterfaces.IScriptHost hostObject) 

        { 

            pspect=hostObject; 

        } 

 

        public void PSpectScript() 

        { 

            // Number of times to repeat acquisition 

            const int totalPasses = 10; 

 

            // Choose a file name stem which will be appended by the repeat number 

            const string saveFileStem = "Measurement"; 

                                     

            //Set measurement live time in seconds 

            pspect.setLiveTime(30); 

                                                 

            for (int p = 0; p < totalPasses; ++p) 

                        { 

                                    pspect.eraseActiveSpectrum(); 

                                    pspect.startAcquisition(); 

                                    pspect.waitForAcquisitionStop(); 

                                    string fileName = string.Format("{0}_{1}", saveFileStem, p + 1);  

                                    pspect.saveActiveSpectrum(fileName); 

                        } 

            }            

    } 

} 
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Example: repeat measurements with multiple detectors 

 

namespace USBSpect{ 

    public class Script : ScriptInterfaces.IScriptScript 

    { 

        ScriptInterfaces.IScriptHost pspect; 

 

        public void InitializeScript(ScriptInterfaces.IScriptHost hostObject) 

        { 

            pspect=hostObject; 

        } 

 

        public void PSpectScript() 

        { 

 // The serial numbers of each of the detectors 

 string[] detectorSerialNumbers = new string[] {"Serial  1", "Serial 2"}; 

    

            // Number of times to repeat acquisition 

            const int totalPasses = 5; 

 

            // Choose a file name stem which will be appended by the repeat number 

            const string saveFileStem = "Measurement"; 

                                     

            // Set measurement live time in seconds 

            pspect.setLiveTime(60); 

                                                 

            for (int p = 0; p < totalPasses; ++p) 

            { 

  foreach (string det in detectorSerialNumbers) 

  {   

   pspect.setActiveSpectrum(det); 

                     pspect.eraseActiveSpectrum();                              

  } 

     

  pspect.startAcquisition(); 

                 pspect.waitForAcquisitionStop(); 

 

  foreach (string det in detectorSerialNumbers) 

  { 

                  pspect.setActiveSpectrum(det); 

   string fileName = string.Format("{0}_{1}", saveFileStem, p + 1);  

                    pspect.saveActiveSpectrum(fileName); 

  } 

            } 

        }            

    } 

} 
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Execution at start up 

A script can be run automatically when the software is started by adding the script 

file specification as a command line argument when executing the application. For 

example, the following will run KSpect/MultiSpect and then load and run the script 

ExampleKSpectScript.cs located in the root directory of the C: drive.  

1. Select Run from the Start menu. 

2. At the Open: prompt enter (include the quotation marks): “C:\Program 

Files\Kromek\Multispect\Multi-spect.exe” “C:\ExampleKSpectScript.cs” 

3. Click the OK button to run the command. 
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